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For Remote Field Installations

The Vantage Pro WeatherLink Downloader allows a Palm Pilot PDA to down-
load archived weather data from a Vantage Pro weather station console or 
Weather Envoy for transfer to WeatherLink on the PC.

Requirements

• Vantage Pro Weather Station or Weather Envoy
• WeatherLink Software version 5.3 or later
• Palm or Palm-compatible PDA with serial interface
• Palm OS 3.5.1 to 4.1

Installing the Software
The first step is to install the WeatherLink Downloader software on your Palm.

Note: These instructions were written for Palm Desktop 3.1.1. If you are using different 
software for your Palm OS PDA, please refer to the instructions for your software 
to install the WeatherLink Downloader software.

1. Open the Palm Desktop or equivalent software on your PC.

Note:If you haven’t yet installed the Palm Desktop or equivalent software on your 
computer, please refer to the instructions that came with your PDA to install the 
software before proceeding.

2. Click the Install button from the programs tool bar, from the View menu, or 
press the F7 function key. Or, click the Windows Task Bar Start button, high-
light Programs, highlight Desktop, and select Install Tool.

3. Verify that the correct user account is displayed in the User box. 

4. Click the Add button in the Install Tool dialog box

5. In the Open dialog box, locate and select “weatherlink.prc” which is on the 
WeatherLink Downloader CD. 

6. Click the OK button in the Open dialog box.

7. Click the Done button.

8. Place your Palm PDA in the Hot Sync cradle.

9. Press the Hot Sync button on the cradle. The Palm Desktop automatically 
installs the WeatherLink Downloader software on your Palm.
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Configuring WeatherLink Downloader
Before you can download weather data into your Palm, you must create a sta-
tion in the WeatherLink Downloader software and set the serial port data rate. 
You can also set the unit of measure used in the weather summary display.

Create a New Station

1. Open the Palm Launch window and tap on the WeatherLink icon .

2. Tap WeatherLink Downloader in the title area at the top of the screen.

3. Tap New Station in the drop-down File menu.

4. Enter the station name.

• The station name can be up to 8 characters long.

Note:You can give it any name you like, but we suggest using the same station name 
used in WeatherLink.

5. Tap Done when you are finished entering the name. The station name 
appears in a text field. 

6. Tap OK to save the new station, tap Cancel to exit without saving the station.

Set the Serial Port

1. Tap WeatherLink Downloader in the title area at the top of the screen.

2. Tap Setup in the menu bar.

3. Tap Serial Port.

4. Tap in the appropriate check box to select the data rate you will use to down-
load from your Vantage Pro console. 

• 19200 is the default setting for the Vantage Pro console. The data rate you 
select here must match the configuration on the console.

• You must use 19200 to download from a Weather Envoy.

5. Tap OK to save the new setting or tap Cancel to exit without changing the 
setting.

Set Units

1. Tap WeatherLink Downloader in the title area at the top of the screen.

2. Tap Setup in the menu bar.

3. Tap Set Units.

4. Select the units of measure to be used for the listed weather data parameters.

• You can set the units for temperature, rain, barometer, and wind speed 
measurements.

5. Tap OK to save the new setting or tap Cancel to exit without changing the 
setting.
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Downloading Weather Data to Palm PDA
Use the following instructions to download archived weather data from a Van-
tage Pro console or from a Weather Envoy.

Note: Each download to the Palm will automatically overwrite the previous download for 
that station in the Palm. The entire data logger archive is downloaded each time.

1. Referring to the illustration, use the supplied 9-pin cable adapter and your 
Palm serial cable to connect your Palm to the data logger installed on a 
Vantage Pro console or Weather Envoy. 

2. Open the Palm Launch window and tap on the WeatherLink icon .

3. Tap WeatherLink in the title area at the top of the screen.

4. If necessary, open a station by Tapping Open Station in the drop-down File 
menu, tapping the name of the Palm station you will be downloading to, 
and tapping OK to select the station.

5. Tap WeatherLink in the title area at the top of the screen.

6. Tap Download in the drop-down File menu. The Download window shows 
download status as the data is transferred to the Palm .

7. When you see the Download Complete message, tap OK to return to the 
WeatherLink Downloader main window.

8 feet (2.5 m)
Data Logger Cable

(standard)

Vantage Pro ConsolePalm Pilot

Battery Cover
Data

Logger

Serial Port
Cable

9-Pin
Cable Adapter

Palm PDA to Vantage Pro Connections, Weather Envoy Connection is Similar
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Checking the Download Info / Clearing the Database
Use the following instructions to view information about the Palm database or 
to delete the Palm database.

1. If necessary, open the WeatherLink Downloader software by tapping on the 
WeatherLink icon in the Palm PDA Launcher.

2. Tap WeatherLink Downloader in the title area at the top of the screen.

3. Tap Open Station in the drop-down File menu.

4. Tap the name of the station for which you wish to view the download infor-
mation or delete the Palm database.

Note:A separate database file is created for each station created on your Palm. Each 
download will automatically overwrite the previous download for that station.

5. Tap OK to select the station, tap Cancel to exit without selecting a station.

6. Tap WeatherLink in the title area at the top of the screen.

7. Tap Download Info in the drop-down File menu. The Download Info win-
dow is displayed.

• The Download info displays the following information about the Palm 
database: date, time, file name, station creation date, number of records 
in the file, and the amount of memory used by the file.

8. If you want to erase the Palm database, tap Clear Database.

9. Tap OK to return to the WeatherLink Downloader main window.

Viewing the Weather Summary
Use the following instructions to display a summary of current weather condi-
tions from a Vantage Pro console or a Weather Envoy.

Note: The Palm must be connected to a Vantage Pro console or Weather Envoy to view 
the Weather Summary.

1. If necessary, open WeatherLink Downloader by tapping on the WeatherLink 
icon in the Palm Launcher.

2. Tap WeatherLink Downloader in the title area at the top of the screen.

3. Tap View in the WeatherLink Downloader menu bar.

4. Tap Summary in the View drop-down menu. The Summary window dis-
plays a short summary of current weather conditions.

The Summary window displays: inside and outside temperature, inside and 
outside humidity, barometric pressure, wind speed, wind direction, average 
wind speed, today’s rain and total rain.

Note:The Weather Summary is a static display of current weather conditions and 
does not update as conditions change. 

5. Tap OK to return to the WeatherLink Downloader main window.
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Transferring Weather Data from Palm to PC
There are two steps to transferring the Palm database into WeatherLink on your 
computer. First you transfer the database from the Palm to your computer. Then 
you import the database into WeatherLink.

Uploading Palm Database to PC

1. Open the Palm Desktop, Hot Sync Manager, or equivalent software on your 
PC.

Note:If you aren’t using Palm Desktop on your computer, please refer to the instruc-
tions that came with your Palm OS PDA software before proceeding.

2. Verify that the correct user account is displayed in the User box. 

3. Place your Palm in the Hot Sync cradle.

4. Press the Hot Sync button on the cradle.

• The weather data on your Palm is automatically uploaded to your com-
puter

• The weather data is transferred to the Palm Desktop user’s Backup 
directory.

• The file is named: “station name-WL01.PDB”. For example, if the station 
on your Palm was named “Davis”, the file name would be “Davis-
WL01.PDB”.

5. If you wish, you can now remove the Palm from the HotSync cradle and exit 
the Palm Desktop.

Importing the Data into WeatherLink

1. Open WeatherLink on your PC.

Note:WeatherLink 5.3 or later is required for use with the Palm Downloader.

2. Look in the title bar of the WeatherLink to see which station is opened. If 
necessary, use the Open Station command on the File drop-down menu to 
open the station into which you wish to import the Palm database.
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3. Click Import Palm Database in the File menu.

The Import Palm Database dialog window appears.

Note:WeatherLink will automatically open the last folder used to import a Palm data-
base.

4. Locate the Palm database file. It will be located in the Backup folder for the 
Palm user that was active during the data transfer to your PC.

5. When you have located the Palm database, double-click file name to select 
the database. The Import Palm File dialog box appears.

6. Click Yes to import the Palm database, click No to exit the dialog box with-
out importing the Palm database.

If you select Yes, the Palm database will automatically be incorporated into 
the data for the currently opened station in WeatherLink.

Note:Only those records more recent than the last record in the WeatherLink data-
base will be copied into WeatherLink.
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Weather Station Configuration Options
When the Palm is connected to your weather station you can check and/or 
change the station’s time and date, the archive interval, or configure the down-
load to automatically clear the archived data in the data logger after the down-
load.

Note: The Palm PDA must be connected to the Vantage Pro console or Weather Envoy 
to perform these operations.

Set Time and Date

1. Tap WeatherLink in the title area at the top of the screen.

2. Tap Setup in the menu bar.

3. Tap Serial Port.

4. Select the data rate that you are using to communicate with your Vantage 
Pro console or Weather Envoy. 19200 is the standard setting.

You must use the 19200 data rate to download from a Weather Envoy.

5. Tap OK to save the new setting. Tap Cancel to exit without changing the set-
ting.

Set Archive Interval

1. Tap WeatherLink in the title area at the top of the screen.

2. Tap Setup in the menu bar.

3. Tap Set Archive.

The list of available archive intervals is shown. The current interval is indi-
cated by a checked box.

4. To change the archive interval, tap the box next to the desired interval.

Note:Changing the archive interval will clear the all data in the data logger.

5. Tap OK to save the new setting. Tap Cancel to exit without changing the set-
ting.

Set Clear Archive After Download Option

1. Tap WeatherLink in the title area at the top of the screen.

2. Tap Setup in the menu bar.

3. Tap Set Archive.

The list of available archive intervals is shown. Under the list of intervals is 
the “Clear Archive a/Download” check box.

If the “Clear Archive” box is checked then the option is enabled. If the box 
is not checked then the option is not enabled.

4. Tap the “Clear Archive...” check box to toggle the option ON and OFF.

5. Tap OK to save the clear archive setting. Tap Cancel to exit without changing 
the setting.
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3465 Diablo Avenue, Hayward, CA 94545-2778 U.S.A.

510-732-9229 • Fax: 510-732-9188
E-mail: info@davisnet.com  •  www.davisnet.com

Contacting Davis Technical Support
If you have any questions about your Palm Downloader or encounter problems 
using the Palm Downloader, please contact Davis Technical Support.

(510) 732-7814 Technical Support, Monday – Friday, 7:00 a.m. – 5:30 p.m. Pacific 
Time

(510) 670-0589 Technical Support Fax

support@davisnet.com E-mail Technical Support

www.davisnet.com Copies of User Manuals, Spec Sheets, and Application 
Notes are available on the “Support” page. Watch for FAQs and other updates. 
Subscribe to the e-newsletter.
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